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1 Introduction

iConfrol installation is wizard-driven. As soon as you start the process from the installation welcome
page (Figure 1 on page 6), the wizard guides you through the steps fo install iControl, starting with
any prerequisite components.

In addition to the installation process, this guide also includes information on administering the
software, activating licenses, and sharing data among multiple iControl/iC applications.

2 System Requirements

Below are the minimum system requirements for the computer where you install iControl. Please
note that these are the minimum specifications fo run the software. Computers with faster
processors will provide a better user experience. For more information on computer
recommendations for iC software, please see the iC Software Computer Specification Guide
available on the Documentation fab at www.mt.com/iC.

To verify the operating system and hardware configuration, right-click on Computer and review the

General tab.
Minimum Requirements

ONE iC/iControl Application MULTIPLE iC/iControl Applications
CPU Intel Core 2 Duo 2.2 GHz or better Intel Core 2 Duo 2.8 GHz or better
Memory 2 GB 3 GB
Hard Drive SATA 5400 rpm SATA 7200 rpm
Graphics SXGA 1280 x 1024 SXGA 1280 x 1024

with 3D hardware acceleration with 3D hardware acceleration
Supported 32/64 bit versions of Microsoft® Windows® 8.1 and Microsoft® Windows® 7
Operating
Systems

Additional software requirements include Microsoft® Internet Explorer® 8.0 Web browser,
Microsoft® Office® 2007, 2010, or 2013, and the latest version of Adobe® Reader® or
other PDF reader.

iControl LabMax 5.3 Installation Guide Page 4 of 26 METTLER TOLEDO


http://www.mt.com/iC

3 Installing iControl LabMax 5.3

Review the following information prior fo installing iControl LabMax 5.3:

3.1 Necessary User Rights
NOTE: You need Administrator privileges on the PC in order fo successfully install the software.

To run iConfrol, normal user privileges are sufficient.

3.2 Updating iControl LabMax 4.0/5.0 with iControl LabMax 5.3

iControl LabMax 5.3 can be installed on the same PC as iControl LabMax 4.0/5.0, although it is
not recommended to run both applications af the same time.

When installing iControl LabMax 5.3 the first time, the following datfa is copied from the previous

iControl LabMax 4.0/5.0 installation:

= Equipment database including all device settings such as device names and COM ports
Note that custom insert types will not get migrated.

= The last used lab equipment including defined reactor, stirrer, cover, inserts and safety limits
Chemical Database

= Sensors ( UCB, RD10) including adjustment data

= Any defined links to other iC applications

After iControl LabMax 5.3 is installed, you are immediately ready to go with the same defined
environment as you had in iConirol LabMax 4.0/5.0. Experiments from version 4.0/5.0 can be
opened without any dafa conversion.

If you sfill want to work with iConirol LabMax 4.0/5.0 AFTER the installation of iControl LabMax 5.3,
you need to upgrade the Equipment database as follows:

= (o to the Start Page of iControl LabMax 4.0/5.0 and click on “Manage Equipment”

= Then click on “Update Database”

Eqmpment \IISend log files monthly
I More Information
Manage Equipment .LLCallbrate Sensors [#]iCortrol Help
uments 8 =
. or add a new instrument below:
Name: LabMax
Description: LabMax with up to 2 RD10%s
Manage Equipment Database
C\Temp\EQDB.mte =

Add, Corfigure and Adjust Equipment. Import Equipment. [ Update Database ]
| |

Print Sensor History...

Select COM ports for LabMax and R

[ LabMax " upgraded to latest version 1.10.68

The old equipment database has been backed up to

E ﬁ COM Port: y
CA\Temp\EQDE.mte.Backup from 2015-01-21 17-13-02.mte

Upgrade Equipment Database to |atest version I @

{ L | Equipment database C:\Temp)\EQDE.mte has been successfully

NOTE: Before starting the iControl LabMax 5.3 installation, please logout or reboot to close all
active iControl LabMax 4.0/5.0 processes. Then proceed fo the next section fo begin the
installation process.

Information about uninstalling iConirol LabMax 5.3 can be found on page 26.
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iIControl LabMax Installation

3.3

3.4

Migrating from WinRC 7.x to iControl LabMax 5.3

iConfrol LabMax 5.3 can be installed on the same PC as WinRC 7.x, although it is not
recommended to run both applications at the same time.

iControl LabMax 5.3 does not automatically migrate and apply any configuration data from WinRC
7.x but the Equipment Database file (*.mfe) may be used in iConirol as a starting point to define the
equipment.

If you want fo convert existing WinRC 7.11, 7.12, 7.5, 7.6 experiments to iControl LabMax 5.3,
then you can use the iControl Data Conversion Utility which is available as a separate installer on
the iControl LabMax 5.3 DVD-ROM in the folder “Data Conversion Utility” or more conveniently from
the AufoPlay application which should start when you insert the iConfrol LabMax 5.3 DVD-ROM.

NOTE: Before starting the iControl LabMax 5.3 installation, please logout or reboot to close all
active WinRC 7.x processes. Then proceed to the next section to begin the installation
process.

Starting iControl LabMax 5.3 Installation
NOTE: It is recommended that you close all open programs prior to starting the installation.

When you insert your iControl LabMax 5.3 DVD-ROM into the PC’s DVD drive, the AufoPlay
application should start automatically. From the installation welcome window, you can click the
Install iControl LabMax™ 5.3 button to start the installation.

v iControl LabMax™ 5.3 Software DVD-ROM

I iControl Software I Information
f Thank you for purchasing iControl LabMax™
Install iControl LabMax™ 5.3 ¥ P 9
[ o T ] 5.3, the simply powerful software package for the
iControl LabMax™ 5.3 can be installed without removing previous iControl or WinRC versions. LabMax™.

Please read the Quick Start Guide (" pdf) for instructions on how to install iControl. . . ;
Everything you need to install and run iControl
LabMax™ 5.3 can be found on this installation

I Additional Software CD-ROM.
[ Links to the various webpages as well as to the

Install Data Conversion Utility AutoChem Community Site are found in
addition.

This utility allows you to convert experiments and chemicals from iControl LabMax™ 3.3 as
well as experimental data from WinRC 7.11, 7.12, 7.5 and 7.6 into iControl RC1e™ /
LabMax™ 5.3 Experiment files (*.iControlRC1e / *.iControlLM).

Experiments created in iControl LabMax™ 4.0/5.0 can be opened in iControl LabMax™ 5.3
without doing any data conversion.

The AutoChem Community Site requires a
password that is automatically issued when
you register for the iControl LabMax™ software
or any of its options. It is sent by e-mail to your
attention.

Install Mixing Guidelines

The mixing guidelines provide you with an insight into the fundamentals of mixing and mass
transfer and the concepts associated with. It is an easy-to-understand tutorial that explains the I
concepts in theory and with examples helps to understand the mixing process inside the reactor.

A side-by-side video comparison allows observing the mixing behavior with different stirrer types iControl Software on the web
and stirring speeds.

Links

RTCal on the web

I Supporting Documents METTLER TOLEDO AutoChem
Release Notes (* pdf) Quick Start Guide (*.pdf) AutoChem Community Site
Installation Guide for IT Administrators (*.pdf) ALR Product Catalog (*.pdf)
© 06/2014 Mettler-Toledo AG, AutoChem, Sonnenbergstrasse 74, CH-8603 Schwerzenbach, Switzerland, Phone +41-44 306 77 11, Fax +41-44 306 72 90

Figure 1 Installation welcome dialog box

If the AutoPlay function does not start automatically, then you can also run the autorun.exe or
setup.exe directly from the iControl LabMax 5.3 DVD-ROM root directory.

The iControl Installation wizard will automatically walk you through installation of any needed pre-
requisites, like .Net Framework 4.5 and SQL Server Compact Edition. The following chapters
describe the installation process in detail.
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iIControl LabMax Installation

3.5

Notice about prerequisite installations:

Some of these prerequisite installations may ask you to reboot the computer. Please do as
requested and reboot. After you have logged in again, you may need to restart the iControl
LabMax 5.3 installer by double-clicking setup.exe on the installation DVD-ROM root
directory. The installer will then confinue to the iControl installation.

After successful installation of all of the prerequisite installers, the iControl LabMax 5.3 main
application installer appears:

( A
1) METTLER TOLEDO iControl LabMax 5.3 [

METTLER TOLEDO

iControl LabMax™
Installation Wizard

(2

Mettler-Toledo AG, AutoChem
Sonnenbergstrasse 74
CH-8603 Schwerzenbach, Swifzeriand

Cancel

I
&

J

Select Next and move through the wizard steps fo install iControl LabMax 5.3.

Installed Application Shortcuts

The iControl LabMax 5.3 installer installed the following shortcuts under your Start menu
Start > All Programs > METTLER TOLEDO > iControl LabMax 5.3:

Shortcut

iControl LabMax
5.3

Description

Main Application. Click this shortcut fo start iControl LabMax 5.3

Release Notes

PDF document which describes the known issues with iConfrol LabMax
5.3. It is recommended fo read this to understand the currently known
limitations

Send iControl Logs
To Customer Care

This is a utility that gathers the necessary information fo provide to
METTLER TOLEDQO Customer Care in case of a support issue

Temperature Control
PI Estimator Utility

For advanced users: This Excel spreadsheet is used to fine tune the Pl
control parameters for your thermostat. Details are described in the
iControl LabMax 5.3 online help.

Service Features

This is designed for the METTLER TOLEDO Field Service Engineer (FSE)

The iControl LabMax 5.3 installer also installs a shorfcut on your deskfop to start the iControl
LabMax 5.3 application.
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3.6 Starting iControl Software

1. Start the iControl software application by double-clicking the desktop icon or selecting iControl
LabMax 5.3 from the METTLER TOLEDO program group in the Start menu.

. METTLER TOLEDO

or . iControl LabMax 5.3
[cd iControl LabMax 5.3 m
T Release Motes

L;E“H;xméﬂ [ Send iControl Logs
IE_|’| Temperature Control PI

. Service Features
2. The following message indicafes the software is running on a frial license:

NOTE: If the iCare Software Mainfenance subscription or Site License is current on this PC, the
system will automatically be licensed and the user will not be prompted to activate the
software.

Trial Version

“You are running a trial version of iControl 5.2 Instrument. To continue using this Software after the trial period, you need to enter a valid product activation code. The iCentrol 5.2 Instrument trial license will expire in 26 days on 52212013,

= Ifyou have a License Key, click Activate Now to proceed with the registration process.
Instructions begin under 6 iControl/iC Licensing on page 12.

= If you prefer to remain on the 30-day trial license, click Activate Later.

NOTE: The 30-day frial provides access fo all iConirol LabMax 5.3 featfures.

3.8 Checking for Updates

Help If you already have iControl LabMax 5.3 installed and
[Eelie GIED would like fo see if you have the latest version or release,
(Ciarnie] ofp e 2 select Check for Updates from Help menu.

AutoChem Community 'ebsaite
| Check for Updates |

Licenze Manager

Send iControl Logs to Customer Care

About iContral

iControl LabMax 5.3 Installation Guide Page 8 of 26 METTLER TOLEDO



iIControl LabMax Installation

3.9 Installing iC Data Center and connecting iControl

iC Data Center is a key enabling fechnology that captures data from all connected instruments at the
end of an experiment and stores it in a central location. Upon experiment completion several useful
report files in common formats are automatically prepared and an email is sent to the experiment
executer with links to the files. iC Data Center enables data sharing among chemists, engineers and
their colleagues as well as providing a pathway for uploading experiments to electronic lab
notebooks (eLN) and data management systems.

Laboratory Office

iC Dot? Center —

- N\ AT\
Capture Prepare Share S o

More information on iC Data Center can be found in the iC Data Center Overview video provided in
the Tutorial Video section available from the iConirol start page.

To connect iControl to an existing iC Data Center installation, go the main Tools menu and select
Configure iC Data Center. Check the checkbox and enter in the full name or IP address of the iC
Data Center server. Use the Test Connection butfon to verify communication.

-

[:4 iControl LabMax 3.3

File Edit View Experiment | Tools | Windows Help
Dt B RE & Or

l Configure iC Data Center... l

/"l start Page | T Lab
. ﬁ 49 ]u [:4 iC Data Center ﬂ

Use iC Data Center

Server address:  uslOs-devDB.am.mt.mimet

e.g. Computer name or [P Address

9
&% —! Experiment

Successfully connected!

Create and organize your exper

ok || cancel || Help |

Start Experiment l T DESTYIT CAPETITETT | [ SUTITgUTe YUTETITETE ] Gamordte Se
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4 UCB Firmware Update

The UCB (Universal Conirol Box) is an optional hardware component that can be used with your
thermostat. It allows additional sensors and actors such as dosing pumps and valves to be used in
conjunction with the reactors.

NOTE: If you were not already running iControl LabMax 5.0, then to use an existing UCB with
iControl LabMax 5.3, you will need fo update the firmware on this box.

On the iControl LabMax 5.3 DVD-ROM in the “Firmware” folder, you will find the following firmware
file that can be used fo update the UCB:

Box-type ‘Version ‘Filenume

ucB

3.4.2 AlrFirmware_iControl_UCB_3_4_2.alrfw

To update the UCB firmware:

1. Open Configure Instruments from your iControl LabMax 5.3 Start Page.
2. Click Add Instrument... and select the UCB instrument.

3. Select the “Service Tools” tab and click on Download Firmware. You will need fo select the
appropriate serial port for the UCB and browse for the firmware file mentioned above. Click the
Download fo initiate the transfer.

[4 Configure Equipment

IS RCle
15 uce

Name: uce

Description Universal Control Box

| Connection | Sensors and FCEs | ServiceTools

Update the Fimware on the UCB

Download fimware:

Serial port

Download
Firmwiare file:

C:\AlrFimware_iControl_UCB_3_4_2 alfw

Download |

Download messages

ssee
IR

.=
a0

..
° B89
"
LR

"8 sa
B E66

Add Instrument... Stop Instrume ve

[ sa ] [ Close

][ Hele

For more defailed information, refer to the iControl Online help (Search for “Download Firmware”).

iControl LabMax 5.3 Installation Guide Page 10 of 26
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5 Installation of Multiport Adapter

The Multiport adapter is used to connect the thermostat, and RD10 or a UCB (Universal Control
Box) to a USB port. The USB-RS$422 adapter VScom USB-4COMi-SI works with Microsoff®
Windows® Vista, Microsoft® Windows® 7, and Microsoft® Windows® 8/8.1.

The various drivers are found on the VScom Product Drivers and Manuals CD-ROM, which is
shipped together with the multiport adapfer or can be downloaded from hitp://www.vscom.de

The following chapters in the manual provide a brief overview on the installation of the mulfiport
adapter:

1. Boot the system and log in under an administrative user account.
2. Insert the VScom CD-ROM into your CD drive.

3. Check seftings of the jumper on the USB multiport adapter, as defined on the USB adapter for
use as RS422 adapter chapter:
e Jumpers 1 and 2: ON
e Jumpers3and4:  OFF

4. Plug the cable of the adapter info the USB port on the PC. Windows will start looking for device
drivers since the adapter is Plug-and-Play. Go through the wizard and if necessary specify the
appropriate path driver (located in the CD drive directory). The COM Port numbers start with the
first available.

5. Areboot of the system is not necessary to complete the installation.

If you run info problems during the installation, please see the following problem descriptions:

Problem Solution
1 | System doesn’t recognize the new Go fo the Control Panel -> System and Security
device -> System -> Device Manager and open the

USBDevice (or the USB component with the yellow
mark) and re-install the respective driver. Then
subsequently, reboot the PC.

2 | System doesn’t find the 4 COM ports Reboot the PC

3 | COM ports are not found any more affer | Reboot the PC
unplugging and re-plugging of USB
adapter

If this does not help, please refer to your service engineer or confact support af support.rxe@mt.com
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6.1

iControl/iC Licensing

iControl applications use a licensing scheme fo control distribution and use of the software. Below
are the types of licenses.

Instrument version—Enables the application to connect to an instrument and run experiments.

Office version—Enables the user to run the application without a connection fo an instrument.
With this version, experiment dafa obtained from a computer with an Instrument license can be
viewed and analyzed.

Trial version—A frial version is equivalent to an Insirument license with a 30-day time limit.

Module licenses—Optional add-on modules, allow access o additional features that are
purchased and licensed separately.

iCare subscription—A special annual subscription that entitles you to all major and minor
upgrades and service packs for the Instrument or Office versions of your iC and iControl
Software as well as priority telephone and email support.

Site license—Specific companies that have software agreements with METTLER TOLEDO may
also have a Site License for a parficular product or products. Please refer to page 16 for
instructions on how tfo install a site license.

Using the License Manager to Activate a Single-User License

NOTE: Although you need fo activate your software on a website, the compufer where you are
installing the iControl soffware does not require an internet connection. You can activate the
software license using any internet-enabled computer or by contacting customer support at
iC@mt.com

The following information applies to users installing a single-user Instrument, Office, or Module
license. The first time the iC application starfs, the system displays the Trial License dialog. Choose
to Activate Now or Activate Later.

Trial Version

You are running a trial version of iControl 5.2 Instrument. To continue using this Software after the trial period, you need to enter a valid product activation code. The iControl 5.2 Instrument trial license will expire in 26 days on 52212013

6.1.1 Activate Later — Continue Under a 30-day Trial License

Click Activate Later in the Trial Version dialog box to defer license activation. You can acfivate the
license at any time by selecting License Manager from the iConfrol software Help menu. A reminder
link appears on the iConfrol Start Page to keep you apprised of the frial period.

Help

|£| iContral Help
iControl om the Web

I Reminders

11 29 days left to try iContral EasyM... ) _
AutaChemn Community w ebsite

Check for Updates

Licenze Manager

Send iControl Logs to Customer Care

About iCantral
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6.1.2 Activate Now — Open License Manager and Obtain an Activation Code

When you click Activate Now, the License Manager dialog box opens. The License Manager
contains an 8-character Machine ID and an area to input a 25-character Activation Code field in 5-
character segments. Follow the steps below to obtain the code from the AufoChem Customer
Community Website. The process starts in the License Manager and links to the AutoChem
Customer Community website fo obtain an activation code. Then, you return fo the License Manager
to enfer the code and enable the software.

NOTE: If you purchased iCare atf the same time as iControl LabMax 5.3, activate your 5.3 license
first. Then, follow the steps on page 15 fo activate the iCare subscription.

[.4 License Manager for iControl LabMax &J

Installed licenses

Product Info
iContrel LabMax 5.3 Instrument Single code: 8564)-JTETS-JJAHV-VEGQH-JJCVI

iCare foriControl LabMax Instrument | Notsubsecribed.  Click here for more info

Single license activation procedure
Please follow the 4 steps below to activate your license on this machine. See help for additional information

1. Copy Machine ID: 1234 5678

2. Activate your license key at: https:/community autochem.mt.com

To obtain an Activation code, visit the Mettler-Toledo AutoChem web site using the link above. You will be prompted to log in or
create a user account if you dont have one yet. Once logged in, click the link "Activate an iC oriControl License", enter the
Machine |D along with your 12-digit License Key and then create the Activation Code.

3. Enter Activation Code:

8564)  JT6TS  JJAHV VEGQH  JJCVJ

4. [ Apply Activation Code |

Site license activation procedure

Enable site license:

Contact us with any questions or difficulties:

METTLER 7 TOLEDO METTLER TOLEDO Autochem
7 Phone: +1 866 333 6822
//-//////// Emall:  support. ee@mt.com
’ Close ] i Help

Figure 2 License Manager dialog box

1. Have your License certificate sheet ready. The sheet is usually an Ab-size paper certificate
delivered with the software.

2. Inthe License Manager dialog box (Figure 2), click Copy after step 1 to copy the machine ID
to your clipboard.

3. Click the link (hitps://community.aufochem.mt.com) affer step 2.

NOTE: Access the AutoChem Customer Community website from any internef-enabled PC—this
step does not necessarily need to be performed on the PC where the iControl software is
installed.

iControl LabMax 5.3 Installation Guide Page 13 of 26 METTLER TOLEDO


https://communicty.autochem.mt.com/

IControl LabMax Installation

AutoChem Customer Community

Home Applications Products

METTLER TOLEDO Software | Decumentation = Application Notes | Training Material =~ On-Demand Webinars | User Forum Procsedings
)

Chemical Synthesis, Engineering, and PAT

~

Please log in to Activate an iC or iCare license

Activate an iC License or iCare Subscription

Navigation MT Employee Menu

» Extend IC Trial by 7 Days

ou were looking for? Sul

bt a question to

» IC Licensing Reports irequires VPN)

(E3

Figure 3 AutoChem Customer Community site

4. Depending on whether or not you have an account, start with one of the following steps:

If you are a new user, begin by sefting up a user account (see page 16).

If you already have an account, entfer your username and password and click Log in under

User login or click log in from the red prompt box.

| Please leg in to Activate an iC or iCare license

= Create new account

» Reguest new password

5. Click Activate an iControl or iC License from the My Account

—

Activate an iC or iControl

License

Activate an iCare
Subsoription

Register & Product

tab.

6. Enfer the Machine ID from the iControl License Manager and the License Key from paper

cerfificate.

MT https://community.autochem.mt.com 2 ~ & & || MT Activate an iC License or iC.. %

File Edit View Favorites Tools Help

AutoChem Customer Community

BrideyYahoo | Log out

Activate an iC License or iCare Subscription
iCor Control icare

License Activation Procedure

o (5] o] e
[RBeD - [EFGr -] v

ey, please contact your sales representative

Chemical Synthesis, Engineering, and PAT

METTLER TOLEDO Software | Documentation | Applcation Notes | Training Waterial = On-Demand Webinars | User Forum Proceedings

il =]

®100% ~

Figure 4 Activate License web page
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7. Click Generate Activation Code to produce the code in the fext box. Then, click Copy to save
the code fo the clipboard.

8. Return fo the License Manager in the iControl software, and click Paste or fype in the activation
code in step 3. Enter Activation Code.

2_Aclivate yourlicense key at:  hitps:/community autochem.mt.com
To obtain an Activation code, visit the Mettler-Toledo AutoChem web site using the link above. You will be prompled to

log in or create a user account if you don't have one yet. Once logged in, click the link "Activate an iC ar iControl
License”, enter the Machine ID along with your 12-digit License Key and then create the Activation Code.

3. Enter Activation Code:

| - - | Paste

4. | Apply Activation Code

9. Click Apply Activation Code to complete the activation. You should see a dialog box that
confirms the activation is complete.

10. Repeat the process to activate any module licenses on the PC.

6.2 Activating an iCare Subscription

The procedure to activate an iCare subscription is similar o that for obtaining an activation code
from the AutoChem Customer Community website for a single-user license. The 12-character iCare
Subscription Number is on an iCare Subscription Certificate that shipped with your order.

1. Login to the METTLER TOLEDO AutoChem Customer Community Website.
2. Click Activate an iCare Subscription from the My Account tab.

[

Activate an i€ or iControl

Licsnss

Register a Product

3. Inthe iCare activation window (Figure 5), enfer the Machine ID from the iControl License
Manager for the computer that this subscription should be associafed with.

METTLER TOLEDO S m——

AutoChem Customer Community

Home Applications Products
-EH:

Activate an iC License or iCare Subscription

€ | iCoriControl e | iCare

Subscription Activation Procedure

Pleaze follow these 3 steps to activate your iCare subscription
1. Enter Machine D: [ ] e

NOTE: If you currently h iControl RC1e 3.3 oriC IR 2.0 ol rlier, then please enter 1111 11141
as the Machine ID, otherwise use the Machine ID found on the License Manager dialog (under the Help
menujof your iC software or in the table of activated licenses below

2 Enter Subscription Number: | || || | =5

To obtain an iCare subscription number, please contact your sales representative

3 Activate Subscription

Figure 5 Activate an iCare Subscription window

iControl LabMax 5.3 Installation Guide Page 15 of 26 METTLER TOLEDO



6.3

6.4

Enter the Subscription Number from the certificate sheet.

5. Click the Activate Subscription bufton. You should receive a confirmation email message in a
few minufes that provides some additional information about the program.

6. The email will also include an iCare Subscription Activation Code that can be entered or pasted
back info the License Manager dialog box of the iConfrol software.

Activating the iCare subscription in the software itself is not required, but if you perform this step,
then you will not need to updafe any licensing information if a new iConfrol version is released
before the iCare subscription expires.

Setting Up a New User Account

If you do not already have a user account on the AutoChem Customer Community Website, you will
need to create one before your licenses can be activated.

1. From the AutoChem Customer Community website (https://community.autochem.mt.com),
click the Create new account link.

2. Enfer the required information and accept the ferms.
3. Click Create new account at the bottom of the registration form.

The AutoChem Customer Community websife confirms that an email is being sent:

password and further instructions have been sent to your e-mail address

You will receive an email with instructions and a link fo confirm your email address and complete
the new account registration.

NOTE: Your website regisiration will be pending until confirmed by METTLER TOLEDO AutoChem;
however, you can activate the software by following the link provided in the email.

Wal Customer

Thank you for registering at METTLER TOLEDO AutoChem Custemer Community. Your account is pending approval. In
the meantime, please confirm your email address by following this link and creating a password

AT

https //community autechem. mt.com/index php?g=user/ivalidate/2377/1272317564/18022ch491995c4 2228062258 3daddcd

Until we approve your account for unlimited access to all content (usually within 2 business days). you still have full
access to the following functionality

- activate your iC or iContral software https //community autochem mt com/index php?g=node/422

- register your instrument(s) for warranty

- update your profile (e g. change your password)

If you have questions. please don't hesitate to contact us at autochem community@mt com

Thank you
- METTLER TOLEDO AutoChem Customer Community team

4. Click the first link to confirm your email. You will go fo a one-time login where you create a
password.

5. Affer you change and confirm the password, click Save at the boftom of the page.

Installing a Site License

Most companies do NOT have a site license, so only follow this procedure if specifically directed by
your organization.

NOTE: To use a site license file, the computer must be a member of the company’s named
domain. If the computer is standalone and not on the network, then METTLER TOLEDO can
provide an individual activation code. Please confact your site administrator for assistance.

A Site License is supplied as a file, usually via email and must be loaded into each copy of the
iControl software in use.
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iIControl LabMax Installation

1. To install the Site License, open the License Manager by selecting it from the Help menu.
[ Heln |

E iControl Help
iContral on the Web

AutoChemn Community Website
Check for Updates

Licenze Manager

Send iControl Logs to Customer Care

About iContral

2. Inthe License Manager, click Enable.

o
License Manager for iControl (o m]
nstalled censes
Product Infa
iControl 5 2 Instrument Trial expires n 26 days on 51222013 Click here for mere info
iCaredfor iContrl Instrument ibed.  Click here for mere info

iControl Multi Instrument Option | Not installed. Click here for more info
iControl OptiMax HFCal Option | Notinstalled. Click here toactivate 30 days trizl

Single license activation procedure
Please follow the 4 steps below to activate your license on this machine. See help for additional information.

1. Copy Machine ID: A123  B678

2. Activate your license key at:  htips://community autochem mt.com
To abtain an Activation cade. vist the Mettler-Toledo AutoChem web ste using the link above. Yfou willbe prompted ta log in or

create 3 user account if you dont have one yet. Once logged in, click the link “Activate an iC or iCorttrol License”, ertter the:
Machine ID zlong with your 12-digit License Key and then create the Activation Code

3. Enter Activation Code:

4. | Apply Activation Code

| - stelicense activation procedure

Enable site license:

Contact us with any questions or difficulties:

MEIIIER/, TOLEDO METTLER TOLEDO Autochem
/// Phone: +1 866 333 6822
/ Email:  support e@mt com
[ Close ) [ Help ]

)

3. Click Browse fo navigate to the Site License file location. Then, click OK.
f Load Site License MW

To obtain a site license, contact your Mettler-Toledo representative for further
information. If you already have a site license, enter the license file below.

File name: C:\Daily Temp Files'Site License_With Expiration bin

0K | [ Cancel |

L A

The license loads and the software is ready to use.

4. Repeat on the other computers with iControl installed.
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1.1

1.2

7.3

1.4

Security and Setup Guidelines for IT

This section is intended for IT (Information Technology) depariments fo help them understand the
minimal user privileges and general computer sefup needed fo install and run iControl LabMax 5.3.

Installation Privileges

The installation of iControl LabMax 5.3 requires administrative privileges.

Execution Privileges

To operate iControl LabMax 5.3 normal user privileges are sufficient.

Folders Access Privileges

To operate iControl LabMax 5.3, the logged in user needs read access fo the following folders
including all subfolders:

32-bit Operating System: <Drive>:\Program FilesIMETTLER TOLEDO
64-bit Operating System: <Drive>:\Program Files (x86)\METTLER TOLEDO

To operate iControl LabMax 5.3, the logged in user needs read/write access to the following folders
including all subfolders:

<Drive>:\ProgramDala\METTLER TOLEDO
<Drive>:\Users\<UserName>\AppDara\Roaming\METTLER TOLEDO
<Drive>.|\Users|<UserName> |AppDaralLocallTemp

Registry Access Privileges

To operate iControl LabMax 5.3, the logged in user needs read/write access to the following keys
including all subkeys:

HKEY_LOCAL_MACHINE\SOFTWARE\Mettler Toledo

7.4.1 UDP Ports

All iControl 4.0 (and newer) and iC 4.0 (and newer) application use UDP broadcasts on the UDP
port 1001 (default) to find each other. This happens only if the user presses “Find METTLER
TOLEDO Applications” in an iC application (in the main menu under Tools/Connect fo other
iC/iControl applicatfions..."). In iControl the broadcast is done automatically and does not need to
be friggered manually.

NOTE: It is not required to have this port open. The UDB broadcast is only used fo find and
exchange the Hostname and TCP port settings to connect the iControl or iC applications. All
the actual communications are then done on a TCP link.
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This default UDP port can be changed in the following XML file by setting a different Broadcast Port:
C:\ProgramDara\METTLER TOLEDO\Applicationinio.config. xm/

<?xml version="1.0" standalone="yes"?>
<Applnfos>

<Applnfo>
<Title>iControlLabMax on LocalHost</Title>
<AppType>iConirolLabMax</AppType>
<Version>5.3.28.0</Version>
<Host>ch03w0713.eu.mt.minet</Host>

<Path>C:\Program Files\METTLER TOLEDO\iControl LabMax 5.3\iConirolLabMax.exe </Path>

<Port>3906</Port>

<Index>0</Index>

</Applnfo>
<OtherDefaults>

<BroadcastPort>1001</BroadcastPort>

</OtherDefaults>
</ApplInfos>

NOTE: This file is created when iControl starfs up the first time.

7.4.2 TCP Ports

By default, iConfrol communicates with other iControl or iC applications on the network over TCP
port 3906.

7.5 Check Power Settings

On a PC that will be controlling an instrument, you must adjust the power settings to prevent
interruption of the data collection process.

7.5.1 Never Go into Sleep Mode

Search for ‘Power options.” Set all fo Off, Never, or Disabled.

7.5.3 Disable Hibernation Mode

Check that the ‘Enable hibernation” option is not selected.
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7.6 Deployment Files and Dependencies

An iControl installation has the third-party dependencies listed below.

Third-Party Dependencies Version Third-Party
.Net Framework 4.5 full _

SQL Server Compact Edition 4.0 Microsoft
Windows installer 3.1

An iControl installation deploys the files described below.

iControl Software Deployments Notes
Software and instrument drivers deployed fo Installation path
32-bit Operating System:

C:\Program Files\METTLER TOLEDO\iControl LabMax 5.3
C:\Program Files\METTLER TOLEDO\ALRComponents 5.3

64-bit Operating System:
C:\Program Files (x86)\METTLER TOLEDO\iControl LabMax 5.3
C:\Program Files (x86)\METTLER TOLEDO\ALRComponents 5.3

Miscellaneous configuration files deployed fo:
o C:\ProgramData\METTLER TOLEDO\iControl LabMax\5.3
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8 Sharing Data Between iC/iControl Applications

Using synthesis workstations controlled by iControl with METTLER TOLEDO analytical probes
connected fo iC software has many benefits. See the tuforial video Using iControl and iC Analytical
Probes included with iConfrol for a good summary of how to sefup the connection and the benefits
of using it.

The simplest way to connect iControl and iC analytical software like iC IR, iC FBRM or iC Raman, is
to install the applications on the same computer. If this is the case, then proceed directly to section
8.2 Connecting the iC/iControl Applications.

If iControl and the iC analytical software are on separafe computers then the two PC’s must have an
Ethernet connection between them, either over the corporate network or a private LAN.

& 07 | R
o ! i ‘ Y <—
N— A Ju =
| e
T e’ Network

i — Jn_—

Figure 6 Sharing Data Between Experiments in Real-time

This section provides a general summary of the steps needed fo connect fwo computers running iC
software over a corporafe network. If the PCs and instruments are connected to each other on a
private hub or you have difficulties with any of these steps and need additional troubleshooting
information, then please refer to the full Software Tip Sheet on Sharing Data between iC/iControl
applications which is available on the AutoChem Customer Community websife
(https://community.autochem.mt.com/index.php?q=iCAppinterop)

Before starting the steps below, ensure that:

e The iC and iControl applications on each PC are properly installed and can successfully
execute an experiment with their respective equipment

e The two Computers are connected on the same network

The general approach is to add an exception to the Windows Firewall on each machine and then
configure iControl and the iC applications to communicate with each other.
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IControl LabMax Installation

8.1 Configuring the Windows Firewall

The instructions in this section are only required if the iConfrol software and the iC analytical
software are on different computers. If they are installed on the same PC, this step can be skipped.

1. On the PC running iControl, click the Start -> Control Panel -> System and Security ->
Windows Firewall. (or use the start search option for firewall.cpl)

‘—_3 Balsamiq Mockups Computer 3| M Performance Information anc
& Default Programs
it Desktop Gadget Gallery Control Panel {7 Phone and Modem

&l Personalization

’g Internet Explorer ﬁ Power Options
7 Korea Media Player Center Devices and Printers Programs and Features Programs (1)
"7 Korea Messenger Center i Recovery | 2] firewall.cpl

D Microsoft Web Platform Installer
2 Mindjet MindManager Viewer 7
w Mozilla Firefox

‘Windows DVD Maker

12 Windows Fax and Scan

B Windows Media Center

@ ‘Windows Media Player

7} Windows Update

## Region and Language

. RemoteApp and Desktop Cor
SAP GUI Configuration

| Sound

Speech Recognition I firewall.cpl I
Symantec LiveUpdate (32-bit]
%) Sync Center

42 See more results

1B System

o XPS Viewer
L 77 i Taskbar and Start Menu
P & Troubleshaoting
Back User Accounts
indows CardSpace
| Search programs and files »r | \

dows Defender

7] Wl (] Pos... "B AW... | Ukr.. |7 33
2. Select the Allow a program option.

B0 Windows lndate

T

%v|ﬂ » Control Pafl 3 Sistemandﬁecurlty » Windows Firewall

Control Panel H . .
o Help protect your computer with Win

Allow a program or feature
through Windows Firewall

Windows Firewall can help prevent hackers or mi
through the Internet or a network.

r@ Change notification settings How dees a firewall help protect my computer?
@ Turn Windows Firewall on or What are network locations?
off

@ For your security, some settings are manag

l @ Domain networks

@ Restore defaults
@' Advanced settings

Troubleshoot my network

3. Select the Allow another program bufton (if this button is not enabled, then you may need to
first click the Change Settings button)

==
'7-\' . ﬂ« Windows Fire... » Allowed Programs - Search Control Panel P ‘
Allow programs to communicate through Windows Firewall
To add, change, or remove allowed programs and ports, click Change settings.
What are the risks of allowing a program to communicate? Change settings
@ For your security, some settings are managed by your system administrator.
Allowed programs and features:
Mame Domain  Home/Work (Pri.. Public  Group Policy
o] Antivirus Quaratine Yes
vaya 2050 IP Softphone ] O Yes
¥ AxedaDesktopServer ] O No
[ AxedaDesktopServer m| ] No
[ BranchCache - Content Retrieval (Uses ... ] O [m} No
[ BranchCache - Hosted Cache Client (U... [m] [m] O No
[0 BranchCache - Hosted Cache Server (U... a a O No
[ BranchCache - Peer Discovery (Uses W... O O O No
ChemSFC a O Yes
[ Connect to a Network Projecter O ] O Mo
Core Networking Mo
[ Distributed Transaction Coordinator ] ] O Ne S
Details... Remove
Allow another program...
_ —_—
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iIControl LabMax Installation

4. Select the Browse option and locate:
C:\Program Files (x86)\METTLER TOLEDO\iControl LabMax 5.3\iControlLabMax.exe

P

Add a Program

Select the program you want to add, or dick Browse to find one thatis not
listed, and then dick OK.

Programs:

@Inb&rnet Explorer -

& nternet Explorer (54-bit)
Knowledge Warkbench

31 Launch Axeda_Desktop_Server.exs

&L Mail Client

BMDM Data Manager

¥ Microsoft Silverlight L9

) poFCreator

[E) Query Designer

eport Designer

SAP GUI Configuration -

=1

Path: C:\Windows\system32\msra.exe

What are the risks of unblocking a program?

YYou can choose which network location types to add this gyfa

> 4 P,
" Ml
@& Browse / @
@Qﬂ | <« METTLER TOLEDO » \Controly - [ 44| [ Search iControl 5.2 2|
Organize = MNew folder g== » [ ﬁ
Name ° Date modified Type Size
J Services_EM 9/18/2013 1:59 PM File folder
| Templates 9/18/20131:59 PM  File folder
[:d AutoChemServiceTool. 9/17/2013 2:35 PM Application 907 KB
[ ConfigUpdater.exe 9/17/2013 2:35 PM Application 16 KB
| [ iControl.exe Y 9/17/2013 235PM  Application 41KB|
4 iControlService.exe i 9/17/2013 2:35 PM Application 58 KB
[ RxeDeviceSimulator.exe 9/17/2013 2:34 PM Application 263 KB
File name: iControl.exe - [App\ications (*.exg*.com;*.icd) V]
[ Open |v] [ Cancel I
- ]
Note: If you install a different version of iConfrol, you will need to repeat this process for the
new version.

5. Repeat steps 3-4 and add a program excepfion for:
C:\Program Files (x86)\METTLER TOLEDO\iControl LabMax 5.3\iControlService.exe.

6. On the PC running the iC analyfical software, repeat steps 1-4 and add an exception for
appropriate programs such as:

e  C:\Program Files (x86)\METTLER TOLEDO\C IR 4.3\iCIR.exe

e  C:\Program Files (x86)\METTLER TOLEDO\C FBRM 4.3\iCFBRM.exe AND
C:\Program Files (x86)\METTLER TOLEDO\FBRM Server 4. 3\FBRMServer.exe

e  C:\Program Files (x86)\KaiseNiC Raman 4.1\iCRaman.exe
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8.2 Connecting the iC/iControl Applications
1. Start both the iC analytical software (i.e. iC IR) and iControl.

2. IniControl, click Configure Equipment on the start page, click Add Instrument, select the
appropriate option and click OK:

[ Configure Equipment 8 =
e
] optiva Name EasyMax
15 Optibax Lab )
D;ﬁcﬂntmn' EasyMax -
o [J Add Instrument or Application Link (SR q
A instrument or Appiication Link I
9| [Name Desaription |
d| Essymax 102 EasyMax 102 (10 ml ... 100 m)
EasyMax 402 EasyMax 402 (100 ml ... 400 m)
OptiMax 1001 OptiMax 1001 (250 ml ... 1000 mi)
uce Universal Control Box
iC Data Share Application link to iC Data Share
iC FERM Application link to iC FBRM
. T
iC Raman Application link to iC Raman
IC UV-VIS Application link to iC UV-VIS
[0k ][ cancel | [ Hep
Selectani
to configure.
Note: You cannot edit an instrument
whie s arline.

3. Enter a name for the analytical instrument probe and click OK. If you are using a multiple probe
instrument with an EasyMax or two OptiMax systems (one probe for each reactor), then you
will need to do this process twice — adding a new Instrument entry in iControl for each probe.

[ Insert iCIR

Instrument Information
Name: iC IR Probe 1
Description: Application link to iC IR

[ oK h ] [ Cancel ] [ Help ]

h

4. Select the option for the iC analytical software being installed on a different PC and enter the
computer name or IP address

r ]
Configure Equipment L@g
g ST

+- M| EasyMax
| OptiMax
OptiMax Lab Description: Application link to iC IR
iC IR Probe 1

Name: iC IR Probe 1
Note: [f you are using a muli-probe instrument, then you have to create one Application Link
per probe.

Seitings
iC IR is installed on this PC

@ iC IR is installed on a different PC
PC Mame or IP address:  US10L-JN233Q7.am mt.minet

Communication between iControl and iC must be enabled in the Firewall Settings
on both PCs! See figre for a guide on how to configure your Firswall

Test Connectien

Select an instrument from above
to configure.
Note: *You cannot edit an instrument
while it is onling

S ] (o ) [
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8.3

5. Make sure the iC software is running on the other PC and then click the Test Connection butfon
to verify communication.

[id Configure Equipment Bl =
o [B] EasyMax Name iC IR Probe 1
-] OptiMax
A OptiMax Lab Pacadati o =
L iC IR Probe 1 Connected @
\_0] Successfully connected to iCIR on US10L-JN23301 . am.mt.mtnet
\
on both PCs! See here for a guide on how to configure your Firewal
Test Connecticn
Select an instrument fromabove
to configure.
Note: You cannot edit an instrument
while it is online
[Coe ] [ ) [

6. |If the fest is successful, save the configuration. If iControl cannot communicate with the iC
computer and the firewall has already been updated, then see the more extensive connection
guide available on the AutoChem Customer Community website:

https://community.autochem.mt.com/index.php?g=iCApplnterop

Verifying Connection

To verify that the connection is working for all aspects of the interface, perform the following checks:

8.3.1 Check that iControl Can Connect to iC

Start a new experiment and include the iC device in the equipment setup

Execute the run and verify that you can start a new iC experiment from the iControl wizard
Verify that the iC experiment starts when the iControl experiment starts

Check that the iC operations can be used in the iControl procedure (change sample
interval, pause, efc.)

Add iC trends to the iConfrol Trend Viewer

Try a different experiment that specifies a femplate file (note that the path for the template
file should be from the iC application point of view)

Ll A

o o

8.3.2 Verify iC Connection to Another iC or iControl Application

1. Add trends from an open experiment in one application fo the other iC applications’ live or
completed experiment

2. \Verify that live trends from one iC application are correctly updated in a live experiment on
the other iC application

If you encounter any issue and need further instructions or troubleshooting ideas, then please refer
to the full Software Tip Sheet on Sharing Data between iC/iConfrol applications which is available on
the AutfoChem Customer Community website:
https://community.autochem.mt.com/index.php?q=iCApplinterop
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9.1

9.2

9.3

Uninstalling iControl LabMax 5.3

Below are instructions fo uninstall the current or previous versions of iControl software and the
prerequisite softfware applications.

Uninstalling iControl LabMax 5.3 Application

NOTE: Uninstalling iControl LabMax 5.3 will not uninstall or delete any experiments, equipment
database, license activation, or user settings—all data is refained. So, affer you reinstall
iControl LabMax 5.3 (or install a future version of iControl) all of your data will be
accessible again.

To uninstall the iControl LabMax 5.3 application, open Uninstall a Program from the ‘Control Panel’
and select the “iControl LabMax 5.3" entry.

Click Uninstall fo start the removal process and follow the instructions in the uninstall wizard.

Uninstalling Previous iControl Installations

When uninstalling a previous iControl installation such as iControl 4.0/5.0, remove only the
iControl installation. Do nof remove any METTLER TOLEDO ALR Components installations.

Uninstalling Prerequisite Software

Please note that iControl LabMax 5.3 requires several prerequisite applications to run. Uninstalling
any of the prerequisite applications may lead to unexpected behavior in iControl or affect other
applications installed on the PC. The following table shows the required prerequisites per product:

Microsoft .NET Framework 4.5 Microsoft SQL Server Compact 4.0

iControl X X
LabMax 5.3

9.3.1 Uninstalling Microsoft SQL Server Compact 4.0

To uninstall Microsoft SQL Server Compact 4.0, open Uninstall a Program from the ‘Control Panel’
and select the ‘Microsoft SQAL Server Compact’ entry. Then click Uninstall to start the removal
process and follow the uninstall wizard.

9.3.2 Uninstalling Microsoft .NET Framework 4.5

NOTE: Microsoft .NET Framework 4.5 is a basic infrastructure component of your Windows
operating system and therefore uninstalling it is not recommended.

To uninstall the Microsoft .NET Framework 4.5, open Uninstall a Program from the ‘Control Panel’
and select the ‘Microsoft .NET Framework 4.5 entry. Click fo start the removal process. Follow the
uninstall wizard instructions.
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